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Introduction:

The focus of this online course critique is ENGL 1010: Composition 1. The course is
offered at a local community college and serves as an introduction to expository writing. In
ENGL 1010, students work on developing critical thinking, argumentation, and research skills
while learning how to effectively communicate in a variety of modes. I chose this course to
critique for two very specific reasons; [ want to teach college level writing courses and I want to
teach online courses. My goal is to do both effectively. The online course critique will allow me

the opportunity to observe, participate, and reflect on effective (or ineffective) course design.

After requesting permission, I was granted access to the hybrid course by the instructor,
Professor X*' and Dr. Y*, Director of Academic Technology. Per my request, I was granted
access as a student to the course management system Desire to Learn, or D2L, and as such

received all forms of class communication.
Participant Experience:

I learned upon enrollment that ENGL 1010 was a blended course. What does “blended
course” mean? According to Conrad and Donaldson (2012), blended refers to “educational
settings that include both an online and a face-to-face component”. In this particular case, all
course documents (assignments, etc.) are located strictly online as is all course information and
grades. While students do complete the majority of their work online, they are required to attend
a face-to-face meeting once every four weeks. During my observation, I learned that the
majority of the work is individualized writing assignments and activities with one peer review

session, one conference, and five discussion board requirements.

As I began my observation two weeks after the spring semester began, students had
already begun their coursework. I decided, since I was starting late, to begin by exploring the
D2L course page. The first thing I noticed about the course page was the efficient organization.
Everything was well laid out, and clearly and consistently labeled with similar font and color

use. The font was easy for me to read, but could possibly require enlargement to accommodate

! *Names have been changed to protect privacy.
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special needs. I also found the availability of the course calendar to be a potentially useful, if

underutilized, tool (see picture below):

D2L Z /NORTHEAST ENGL 101

Course Home Content Discussions Dropbox Quizzes

|

Tuesday, April 1, 2014

< April 2014 >
Sun Mon Tue wed Thu Fri Sat

Upcoming events

The course calendar tool could be used as a visual representation of the semester schedule and is
featured prominently on the course page. The links to each section of the course management
system are in a fixed location near the top of the course page and provide direction for students
who are looking to locate the areas required for use in class; in this particular class, students
interact most with the following areas of D2L: Home, Content, Discussions, Dropbox, and
Grades. Students find all course material posted in the content section. Students complete
required posts in the Discussions area and submit assigned work to the Dropbox. The Dropbox
provides students with immediate feedback on successful work submission and provides
instructors with the option to install a plagiarism detection feature. As both a student and an

instructor, I would say these are invaluable features.

To fully understand both the course management system features and the effectiveness of
the course structure and activities, I completed two individual assignments and two group
activities. The first individual assignment, Formatting and Email Exercise (Appendix A), was an
exercise designed to familiarize students with the use of Word and Dropbox as well as provide
the instructor with a personal introduction to each student. The assignment was posted online and
was to be submitted online. The second individual assignment, Paraphrasing, Summarizing, and
Quoting Exercise (Appendix B), was an exercise designed to familiarize students with the use of
outside sources in the writing classroom. The assignment was delivered during one of the

courses scheduled face-to-face meetings and was completed and submitted during the scheduled
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meeting time. The two group activities I completed were discussion assignments posted in the

Discussions section of D2L (see pictures below):

Tell Us Something About Yourself
List three things about yourself that the group might remember you by.

Discussions List View Topic View Thread ¥ Settings @ Help Q

ﬂ In the Know - 3 Random Facts ~ < >

Created by Jamie Cyphers on Feb 10, 2014 1:17 AM

Most of my friends will tell you I'm pretty open and straight-forward, so coming up with three random facts about myself that I was
*  willing to share was not difficult!

« I have a Boxer named Sookie who I am pretty sure is the greatest dog in the world.
« I was fortunate enough to attend Lego KidsFest in Raleigh, North Carolina, and it was one of the greatest days of my life.
« When it comes to having material things and live musie, I will pick live music EVERY SINGLE TIME.

What have you done right this semester?

For this discussion board, tell us two things you have done right this semester or relate a nice moment you have had regarding your classes. After that, respond
positively to the posts of at least two other students.

Hida Taninre far What hava van Aana rinhkt thic camactar?

Discussions List View Topic View Thread ## Settings @ Help Q

1 Two Things ~ < >
Created by Jamie Cyphers on Feb 13, 2014 10:50 PM

I like to thing I have done more than two things right, but that could just be wishful thinking. One thing thing I've done right is to sync
all my calendars. I juggle multiple schedules, so it's easy to forget things. Important things. Lots of important things. Fortunately, my
calendar sync has helped me use my phone, email, and other devices to keep up with due dates, appointments, and the like. The second
thing would have to be purchasing a new software bundle that will help me with some school projects and, potentially, course planning.

The discussion assignments had two parts: response and comment. Students were required to
respond to each post and comment on at least two classmates’ postings. The discussion

assignments were designed to encourage student interaction and encourage self-reflection.
Elements that Work:

Exploring the course and the course management system was a very beneficial
experience. [ was able to participate and observe in most aspects of the course which gave me a
unique perspective of the successful elements of the course. To me, the most successful
elements of the course were the organization of the course page and accessibility of the course

material and the frequent correspondence of the instructor.

The organization of the course page and accessibility of the course material are extremely
important in an online setting. If students aren’t able to locate and access course material, the

chance of students successfully completing the course is nonexistent. Professor X provided
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students with a well-organized course page (see picture below) and ensured that all features were

fully functioning.

Course Home Content Discussions Dropbox Quizzes Classlist Grades Groups Self Assessments Checklist Rubrics Edit Course Log Out
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Another important aspect of online learning is maintaining an open line of
communication. Professor X did an excellent job in this respect. He kept students up-to-date via
D2L email (see picture below), provided timely feedback on writing assignments, posted grades

in the Grades section of D2L, and posted his office hours for students who preferred face-to-face

meetings.
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Elements that Need Work:

While there were several elements that worked in this online learning environment, there
were also several elements that didn’t. In my opinion, two elements of the course that needed
work were the low levels of interaction between students and the limited use of Web 2.0 tools.
While Professor X kept up a steady stream of communication between himself and the students,

Conrad and Donaldson (2012) make a point of mentioning that engagement should also occur
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“among the students within a course’s learning community”(p. 6). Based on my online and
classroom observations, there was not a high level of interaction between the students. The only
visible interactions between students were the required responses to the discussion assignments.
At the time of my observation, the posted assignments were primarily individualized with only

one assignment requiring peer response or feedback.

As the course was delivered primarily online, the use of Web 2.0 tools could have gone a
long way in promoting interaction among students as well as providing students with alternative
means to achieve course objectives. As D2L offers multiple interactive features and makes it
easy to embed or link outside tools, I was surprised to find that this course offered little of either.
At the time of observation, there was no variety in available course material; everything posted

for student access was in Word or PDF format.
Conclusion:

While this course supplied students with all the required course material to help them
achieve the objectives as listed in the course syllabus, it did very little to create a sense of
community among students as was apparent in both face-to-face and online interactions. While
the delivery method was primarily online, the structure was nearly identical to face-to-face

delivery and felt more like a self-paced learning environment.
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Appendix A

FORMATTING AND D2L DROPBOX EXERCISE

Using the ing sheet 10 this assi andior you're A
Wiriter's MLA papers without a titie page.
write a short pmgmph about yourself that the ing i :

Your full name

The name you prefer to be called

Your major

What you want to be when (or if!) you grow up

A contact phone number and non-D2L email address. The phone
number and email is optional, but helpful.

YYNY¥Y

Be sure to use complete sentences. The last page in the handout shows you how
the paragraph shouid ook

Once you complete the paragraph, email it to me as an attachment using the
D2L dropbox.

To send me a document via D2L. you ne=d the D2L dropbox and your Microsoft
Word pamgraph Send the dropbox attachments as follows:
ur document to a disc drive or the hard drive as a Word

sl oo ueided (# not using Word).
Enter D2L and go to the course home page.
Click on “Dropbox.”
Click on the folder for the assignment you are submitting.
Click on “Add a file™ and then ~Upload” to find the document you are
going to send. Double click on the document name. The document
name should show in the file box under the “Upioad™ button i D2L.
6. Click on "Add.~
7. Ermer a message (if desired) in the "Comments™ box. Please don't ask

estions within the comment box (use emad instead).
5. Click -Submit
o,
1

OheN

Check the results page to make sure you sent the comrect document.
0.Click “Done.”

FORMATTING ESSAYS USING WORD 2010

1) Create a header with your last name and the proper page number (the header
should count your pages). This should be flush with the right margin.
+ Go to the “Insert” menu and click on “Page Number.” You want
“Top of Page” and then “Plain Number 3.7
* Type your last name in front of the number and hit the space key.
+ Click "Close Header and Footer.”

2) Format your page so it will double-space.
+ On the Home tab, in the Paragraph group, click Line Spacing

= = P

+ Click 2. Formatting for the entire document changes to double
spacing (if this is done before typing). You can also highlight
your document and change it to double-spacing using this tab.

3) Put the following information on the first page and the top left of the
document:
+ Your full name
* My name
+ The class and section number
* The day. with the day then month then year (20 Jan. 2012)

4) Center your creative title:
« Select the text that you want to center between the left and right
margins.
+ On the Home tab, in the Paragraph group, click Center. Type
in your text and hit "Enter.”
* Be sure to click back to align left before typing your essay

5) Hit “Tab" once on your keyboard to indent your paragraph and begin
typing your paper!
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Appendix B

in; otin it

1. Short Quote: Cite the passage below as you would for & short quote

Be sure to introduce the quote; quotes should not be sentences unto
themselves. Quotes must be word-for-word.

2. Long Quote: Cite the passage below as you would for a Jong quote for
a research paper. Long quotes should be 4 or more lines. Remember:
quotes must be word-for-word unless you show changes with
brackets or omissions with ellipses. Be sure to introduce your long
quote with a complete sentence and a colon. Also, use one set of

f ellipsis points i ur

3. Summarize and cite the passage below as you would for a research
paper. Condense (shorten) the passage using your own words and

sentence structure. Be sure to credit the author for his ideas and
work using MLA citations.

4. Paraphrase and cite the passage below as you would for a research
paper. Avoid plagiarism. Use your own words, syntax (word order),
and sentence structure; do not omit any of the author's main points;
and do not add any interpretations of your own. Your paraphrase will
most likely be as long or longer than the original passage,

Advertisers use weasel words to appear 1o be making a
claim for a product when in fact they are making ng claim at all.
Weasel words get their name from the way weasels eat the eggs
they find in the nests of other animals. A wease| v make a small
hale in the egg, suck out the insides, then place the €ag back in the
nest. Only when an egg is examined closely is it foyng 10 be hollow
That's the way it is with weasel words in advertising; Examine
weasel words closely and you'll find that they're as hollow ag a
egg sucked by a weasel. Weasei words appear 1o e minny
when in fact they say the apposite, or nothing ay g ’

Source: page §3 from

Lutz, Willinm. Doublespeak. New York: HarperPerennial, 1990, Priny



